CenturyLink CCM HTML GUI Tutorial

CCM Release 9.8
Date: April 15, 2011
Version 3.0
# Table of Contents

INTRODUCTION AND SYSTEM REQUIREMENTS ....................................................... 6
   PC Requirements .................................................................................................. 6
GUI Access .................................................................................................................. 7
   Logon Information ................................................................................................. 7
   Password Information ............................................................................................ 8
General Information .................................................................................................. 10
   About this Document ............................................................................................ 10
   Help Menu Index ................................................................................................ 10
   Help Menu Contents ............................................................................................. 10
Application Menu Page ............................................................................................. 11
Main Menu Description: ........................................................................................... 12
   Station Management: ............................................................................................. 12
   Administration: ....................................................................................................... 12
   Network Management: ......................................................................................... 12
   General: ................................................................................................................ 12
System Menu Description: ....................................................................................... 12
   System: ................................................................................................................ 12
Move/Syncs Menu Description: ............................................................................... 13
   Move/Syncs: ........................................................................................................ 13
Help Menu Description: ......................................................................................... 13
   Help: .................................................................................................................... 13
System Tab ............................................................................................................... 13
   Customer ID ......................................................................................................... 14
   Preferences .......................................................................................................... 15
      General Folder: ................................................................................................ 15
      Stations Folder: ............................................................................................... 16
      Request Folder: .............................................................................................. 16
Move/Sync Tab ......................................................................................................... 17
   Common Buttons ................................................................................................ 17
      Schedule Button ............................................................................................... 17
      Last Schedule Msg Button ............................................................................. 17
      Cancel ............................................................................................................... 17
      Help ................................................................................................................. 17
Reports

Reports Common to 5ESS and DMS 100

RCFS - Customer Field Search Report

RCIS Report

RCPU - Call Pickup Groups Report

RCUS - Customized Reports

RDIR - Directory Listing Report

RDNH - Directory Number Hunt Groups

RFLD - Field Names Report

RGIC - Group Intercom Report

RLIM - Limits and Feature Counts Report

RPND Run Report Dialog Box

RSCG - Shared Speed Call Groups Report

RSTN - Station Configurations Report

RUID - Unidentified TNs Report

5ESS Unique Reports

RARO - ARS Route Order Report

RARS - ARS Pattern Report

RCAI - Call Appearance Intercom Report

RCFG - Configuration Groups Report

RLCC - Line Class Code Report

RMSS - Message Service System Report

DMS 100 Unique Reports

RATH - Authorization Codes Report

RCOS - NCOS Codes Report

RMDN-MADN Groups Report

RNCS - NCOS Configurations Report

RNSC - Network Speed Calling Report

Appendix 1 Table of Figures

Appendix 2 Features

My Features

5ESS Feature Description

A

C
INTRODUCTION AND SYSTEM REQUIREMENTS

This is a self-tutorial for the CCM User GUI for DMS100 and 5ESS Switches.*

The GUI allows users to access the system thru a direct internet connection at: 

PC Requirements
Processor – Pentium 450 MHz minimum, 1 GHz or faster recommended
Operating System – Microsoft Windows XP SP3
Memory – 128 MB minimum, 256 MB recommended (Customers running their own 
enterprise applications may require additional RAM)
Hard Drive Required – Minimum 2 GB, 6 GB recommended
Internet connection required, Internet Explorer 7.0
Graphics Adaptor – 800 X 600 resolution, greater than 256 colors, small fonts
Mouse
Color Video Display Monitor (800 X 600)
For Internet Explorer 7.0, from the browser menu, please select Tools ->Internet 
Options -> Security. Please make sure SSL 2.0 and SSL 3.0 are enabled

Note: The above are Telcordia Recommendations. Any MAC/PC with similar or greater 
specifications and a modern web browser such as Firefox, IE, Opera or Safari should 
work as well as Windows Vista or Windows 7.
GUI Access

In your browser address window put in the following url: http://www.qwest.com/largebusiness/products/cms/welcome.html. You should get the web page shown below:

![CCM Home Page](image)

Logon Information

Once you launch the Customer Centrex Manager application, a System Logon page will display. This is a security feature that verifies your logon ID and password before displaying any customer data. *(See Figure 2 below)*

Field Descriptions:

- **User ID:** - Your Customer Centrex Manager logon assigned by your Local Exchange Carrier.
  Type a valid logon in the text field.
- **Password:** - The unique password associated with your logon.
  Type the associated password in the text field.
- **Server:** - The name of the database server you want to access.
You will then receive the “Banner” message. Click the OK button to get to the MAIN page, as shown below.

Password Information

The Password Expired dialog box allows you to create a new password when your old password has reached its preset expiration date. You must create a new password to enter the Customer Centrex Manager. (See Figure 4 Below)

Field Descriptions:

- **Old**: This field is used to specify the old, expired password. To begin the process, enter your current password.
New - This field is used to specify the new password you are selecting. See the information below to determine what passwords are acceptable.

Confirm New - Re-enter your new password.

1. Enter the changed password in the New field. Re-enter the same password in Confirm New.
2. Once you have entered the information, press the OK button.

Password Requirements:
- Passwords must be six to eight characters.
- Passwords must be lowercase letters and/or numbers and no special character (e.g., #, !,*.)
- Your password must differ from your User ID. It may not be the reverse or circular shift of your login name.
- A new password must differ from the old one by at least three characters.

Figure 4 Password Change Screen
General Information

About this Document
This document as created by Qwest IT and is based on information from Telcordia Technologies. It is not a totally comprehensive “How To” for the CCM system but it does provide a good get started point. Someone new to CCM can review it and have a good idea about how to use the system. At any point you can click on the Help tab or button and receive help about the position where you are at. It should be noted that Telcordia has designed the help menu to provide information for the switch type (5ESS or DMS 100) with which you are dealing with.

Help Menu Index

![Help Menu Index View](image)

The Help Menu Index view allows you to select a particular item from the left pane and view information about it on the right pane. You can also use the keyword search box to search for a keyword.

Help Menu Contents
The Help Menu index view allows you to find what you are looking for via an index in the left pane. You can find items that are not addressed in this document here.

Application Menu Page

The Application Menu page contains the following four tabs:
Main (Default menu displayed when you start the application). The Main menu is used to access the majority of the Customer Centrex Manager features and functions. Use the Main menu to perform station specific tasks, administrative functions, network management, and general application functions such as accessing reports, mail, and requests.

System - The System menu is used to change the custid or set preferences.

Move/Syncs - The Move/Syncs menu is used to do Moves, and various TN and group syncs.

Help - The Help menu is used to display or change the broadcast message, access the main help system, or see information about the Centrex Management application.

Main Menu Description:

Station Management:

Stations - Allows you to add, change, or delete Centrex features. Click the Stations option to open a single station or display a list of stations.

Groups - Provides access to functionality that allows you to create and modify Administrative groups. Click the Groups option to open a specific group or to display a list of groups.

Administration:

Authorization Codes - Used to define sets of features and facility dialing privileges, such as restricting dialing privileges to authorized personnel. Click the Authorization Codes option to display the Authorization Codes list page.

Network Speed Calling - Used to create and modify codes that represent longer directory numbers, ranging from local three or four-digit internal extensions to multi digit international destinations. Click the Network Speed Calling option to display the Network Speed Calling list page.

Conferencing - Allows you to schedule conference calls and participants therein. There are two types of conference: the Preset Conference, and the Meet-Me Conference. Click the Conferencing option to display the Conferencing list page.

Network Management:

Network Management - Used to modify a range of network manipulation features such as Centrex routing, Line Screening Code flags, and NCOS mapping.

General:

System Admin Mail - Used to read and send mail.

Requests - Allows you to check the status of pending changes to the database. Click the Requests option to display the Request List page.

Reports - Allows you to generate, view, and print system reports.

System Menu Description:

System:

Customer ID - Use this option to change Customer ID's during a session.

Reset Customer ID - If your System Administrator has made changes to the customer database during your session, use this option to reset the system displays accordingly.

Preferences - Used to set preferences for Stations, Requests, and General items such as password and custid options.

Logout - Exits the Customer Centrex Manager application.
Move/Syncs Menu Description:

Move/Syncs:
- **Sync Authorization Codes** - Allows you to specify the Auth Codes that you want to add to, update in or delete from the database.
- **Sync Meet-Me Conference** - Allows you to add/update all of a customer group's meet-me conference data.
- **Sync Network Speed Calling** - Allows you to specify the Network Speed Calling groups that you want to add to, update in or delete from the database.
- **Sync Preset Conference** - Allows you to add/update all of a customer group's Preset conference data.
- **Sync TN** - Allows you to specify the telephone numbers that you want to add to, update in or delete from the database.
- **Move...** - Use this option to move a TN to a new location.
- **Map TN to Custid** - Displays the TN/Custid Mapping list page. This option is valid only if Chipin feature is supported and turned on for the active custid.

Help Menu Description:

Help:
- **Help** - Use this option to access the main Help system and display the Contents Topic page.
- **Broadcast Message** - Displays the system broadcast message. The broadcast message can be changed from this option.
- **About this System** - Displays release information about the Customer Centrex Manager and copyright acknowledgements.

System Tab

![Figure 8 System Tab](image)
Customer ID

Use this option to change the active Customer ID.

- The Custid is a unique identifier assigned to a customer. It is used to access line and feature information for a specific Centrex group.
- When you click on the OK button, the system will close all open windows and query the database for the information associated with the selected ID.

**Note:** Confirmation dialog boxes will display, if necessary, allowing you to save any information that you may have changed in the open windows.

*Field Description:*

**Customer ID** - Displays a list of valid customer IDs for your logon. Click on a name to change to a new customer ID.
Preferences

The Preferences page allows you to customize your Customer Centrex Manager application. Options include: selecting a default station view, specifying the types of request messages to view, determining your default customer ID, etc...

The Preferences page contains three folders:
- **General** - used to set customer ID and password functions.
- **Stations** - used to set a default station view and feature counts.
- **Requests** - used to set options for displayed request messages.

**General Folder:**

**General Folder Field Descriptions:**

*Initial Customer ID*

- **Use Most Recent** - **Use Default** - Select the appropriate radio button to designate which customer ID should be used when the Customer Centrex Manager opens.

*(Custid)* - If you select the Use Default option, the system will open with the customer ID entered in this text box.

To specify a default custid, select a valid option from the drop-down list.

*Password*
Change Password - Check this box to change your Customer Centrex Manager password.
Old - This field is enabled when the Change Password option is selected.
To begin the process, enter your current password.
New - This field is enabled when the Change Password option is selected.
Enter your new password in this field.
Confirm New - This field is enabled when the Change Password option is selected.
Re-enter your new password in this field.

Once you have entered the information, press the OK button.

Passwords must be:
Passwords must be six to twenty characters. Only the first eight characters are valid.
Passwords must contain at least two uppercase and/or lowercase letters and at least one numeric or special character (e.g., #, !,*,.)
Your password must differ from your User ID. It may not be the reverse or circular shift of your login name.
A new password must differ from the old one by at least three characters, only the first eight characters are compared. An uppercase letter and its corresponding lowercase equivalent are treated as identical.

Stations Folder:

Station Folder Field Descriptions:

Default Station View
Features - Profiles - Select the appropriate radio button to designate which view should be in focus when a station window is opened.
Feature Counts
Warning Threshold - Type in the percentage of feature use that must be reached before feature warnings begin.
All Features - Specific Features - Select the appropriate radio button to designate whether the warning limit is applicable for all features or just a select few.
(Feature Check Box) - Scroll down list of features assigned to your Centrex group and managed through the Customer Centrex Manager. Check the feature boxes to designate that the warning option is applicable.

Request Folder:

Request Folder Field Descriptions:
Displayed Request Messages:

Changes/Moves by System Administrator - Check the radio button that best fits your needs. Valid choices are All, Failed and None.
Your Changes/Moves - Check the radio button that best fits your needs. Valid choices are **All** or **Failed**.

Your Database Syncs - Check the radio button that best fits your needs. Valid choices are **All** or **Failed**.

Requests that are not manually deleted will be automatically deleted in the following format:
- Successful request will be retained for two weeks and then deleted from the request list.
- Unsuccessful or partially successful requests will be removed after four weeks.

Mail and Report Notification Control:

Enable Per Session Mail/Report Notification Check Box:
- Check this box to receive the new mail/request pop-up.
- Uncheck this box to suppress the new mail/request pop-up.

Move/Sync Tab

The Move/Sync tab will show different choices depending on what switch type your custid is in.

Common Buttons

Schedule Button
Command button that opens the Schedule Request dialog box. After you assign a request name, effective date and priority level for the current transaction and press OK, your request is scheduled. Data will be transmitted to the switch based on the scheduling option selected: priority or pending.

Last Schedule Msg Button
Command button that displays the last edit message received in the active window.

Cancel
Command button that closes the page without saving changes.

Help
Command button that opens a help page displaying text about the active dialog box.
5ESS Move/Sync

Figure 10 5ESS Move/Sync Tab

Sync ARS Group
Automatic Route Selection (ARS) synchronization is used in the Customer Centrex Manager to gather or update a Centrex customer group’s predefined ARS Group names, ARS Indexes, and ARS Screening Indexes. ARS synchronization delete will remove a ARS Group name and associated data from the Customer Centrex Manager database (not the switch). The Sync ARS Add and Delete functions are available only to System Administrator.

- You may schedule one Sync Add, one Sync Update or one Sync Delete transaction at a time.
- When a Sync ARS option is selected and a transaction is pending, the Sync ARS page will open with the existing transaction data displayed in the page.
- If there is no pending transaction, the page will display empty fields.
- The type of synchronization, add, update or delete is based on the Sync Tab selected.

Sync ARS Groups Add
Use the Sync ARS Groups Add page to add new ARS Groups into the Customer Centrex Manager database. The system gathers the information from the switch and creates a record for each Group name entered in the Sync ARS Groups Add page. Once the transaction has processed successfully, the ARS group names will be available for assignment.

Sync ARS Groups Update
Use the Sync ARS Groups Update page to update predefined ARS Group names stored in the system database. This function compares the Customer Centrex Manager data with the switch data for the ARS Group names entered in the Sync ARS Groups Update page.

Sync ARS Groups Delete
Use the Sync ARS Groups Delete page to remove ARS Groups from the Customer Centrex Manager database. Once the transaction has processed successfully, the ARS Groups names will no longer be available for display or assignment.
Field Descriptions:

ARS Groups Synchronization fields:

Effective Date - Display only.

ARS Group - The ARS (Automatic Route Selection) Group field is used to specify which ARS Group is to be added, updated, or deleted in the database. The valid value is the 1-8 alphanumeric character name of the group for which you want to modify pattern group data.

ARS Index - The ARS Index field specifies which ARS Index is to be added, updated, or deleted in the database. Switch generics 5e11 through 5E13 have a valid value range 1-4095. Generic 5E13SU and above have a valid value range of between 1-16382.

ARS Screening Index - The ARS Screening Index field is used to specify which ARS screening index is to be added, updated, or deleted, in the database. The valid values for this field are 1-16.

Sync Authorization Codes

Authorization (Auth) code synchronization is used in the Customer Centrex Manager to gather or update a Centrex customer's authorization code data. Auth Code synchronization delete will remove an Auth Code from the Customer Centrex Manager database (not the switch). The Authorization Code feature allows a customer to define sets of both feature and facility dialing privileges, to associate an authorization code with each set, and to use these authorization codes to restrict the dialing privileges to authorized personnel within the context of the authorization code group. The Sync Auth Code Add and Delete functions are available only to System Administrator.

- You may schedule one Sync Add, one Sync Update or one Sync Delete transaction at a time.
- When a Sync Auth Code option is selected and a transaction is pending, the Sync Auth Code page will open with the existing transaction data displayed in the page.
- If there is no pending transaction, the page will display empty fields.
- The type of synchronization, add, update or delete is based on the Sync Tab selected.

Sync Authcode Add

Use the Sync Auth Codes Add page to add new Auth Codes into the Customer Centrex Manager database. The system gathers the information from the switch and creates a record for each Auth Code entered in the Sync Authcode Add page. Once the transaction has processed successfully, the Auth Codes will be available for assignment.

Sync Authcode Update

Use the Sync Authcode Update page to update predefined Auth Codes stored in the system database. This function compares the Customer Centrex Manager data with the switch data for the Auth Codes entered in the Sync Auth Codes Update page.

Sync Authcode Delete

Use the Sync Authcode Delete page to remove Auth Codes from the Customer Centrex Manager database. Once the transaction has processed successfully, the Auth Codes will no longer be available for display or assignment.

Field Descriptions:

Auth Code Synchronization fields:

Effective Date - Display only.

Auth Group - Specifies the Auth Group that the Auth Code will be added to updated in or deleted from.
**Begin Authcode** - The Begin Authcode field allows you to specify a particular Authorization code that you want to add, update, or delete. This code is from 1-15 digits. However, the length must match the length specified on the RATH Report.

To specify an individual Auth code enter the Auth code in this field, leaving the End Authcode field blank.

**End Authcode** - Specifies the Auth Codes that will be added, updated or deleted.

**Auth Code** - Specifies the Auth Codes that will be added, updated or deleted.

To synchronize an Auth Code, enter a 1-15 numeric Auth Code.

---

**Sync Configuration Groups**

The Configuration Groups Synchronization page is used in the Customer Centrex Manager to gather or update a Centrex customer's predefined configuration group names and component numbers stored in the system database. You can enter one or more configuration group names and designate a specific component(s) of a configuration group.

Configuration Groups synchronization delete will remove a Configuration Group from the Customer Centrex Manager database (not the switch). The Sync Configuration Group Add and Delete functions are available only to System Administrator.

- You may schedule one Sync Add, one Sync Update or one Sync Delete transaction at a time.
- When a Sync Configuration Groups option is selected and a transaction is pending, the Sync Configuration Groups page will open with the existing transaction data displayed in the page.
- If there is no pending transaction, the page will display empty fields.
- The type of synchronization, add, update or delete is based on the Sync Tab selected.

**Sync Configuration Groups Add**

Use the Sync Configuration Groups Add page to add new Configuration Groups's into the Customer Centrex Manager database. The system gathers the information from the switch and creates a record for each Configuration Group entered in the Sync Configuration Groups Add page. Once the transaction has processed successfully, the Configuration Groups will be available for assignment.

**Sync Configuration Groups Update**

Use the Sync Configuration Groups Update page to update Configuration Groups stored in the system database. This function compares the Customer Centrex Manager data with the switch data for the Configuration Groups entered in the Sync Configuration Groups Update page.

**Sync Configuration Groups Delete**

Use the Sync Configuration Groups Delete page to remove Configuration Groups from the Customer Centrex Manager database. Once the transaction has processed successfully, the Configuration Groups will no longer be available for display or assignment.

---

**Field Descriptions:**

**Configuration Groups Synchronization fields:**

**Effective Date** - Display only.

**Configuration Group** - Specifies the configuration group that will be added, updated or deleted based on the available switch data.

To Update or Delete synchronize a Configuration Group, select an existing Configuration Group from the drop down lists. To Add synchronize a Configuration Group enter a 1-8 character new Configuration Group name.
Select Components - A series of check boxes, 1 through 7, that allow you to designate which configuration group components will be synchronized.

- To specify individual components, check the associated boxes in each row.
- To specify individual components that will be applicable for all rows, press the All button located at the top of each column.

Note: If a component or set of components are not specified the default is 0.

Sync Feature Class of Service (FCOS) Code

Feature Class of Service (FCOS) Code synchronization is used in the Customer Centrex Manager to gather or update a Centrex customer's FCOS Code data. FCOS Code synchronization delete will remove a FCOS Code from the Customer Centrex Manager database (not the switch). The FCOS Code defines the privileges authorized by the Auth code. FCOS codes must be loaded into the database before they can be assigned to Auth codes. Up to 16 FCOS codes can be specified. The Sync FCOS Code Add and Delete functions are available only to System Administrator.

- You may schedule one Sync Add, one Sync Update or one Sync Delete transaction at a time.
- When a Sync FCOS Code option is selected and a transaction is pending, the Sync FCOS Code page will open with the existing transaction data displayed in the page.
- If there is no pending transaction, the page will display empty fields.
- The type of synchronization, add, update or delete is based on the Sync Tab selected.

Sync FCOS Code Add

Use the Sync FCOS Code Add page to add new Auth Groups and associated FCOS Codes into the Customer Centrex Manager database. The system gathers the information from the switch and creates a record for each Auth Group and associated FCOS Codes entered in the Sync FCOS Code Add page. Once the transaction has processed successfully, the FCOS Code will be available for assignment.

Sync FCOS Code Update

Use the Sync FCOS Code Update page to update FCOS Codes stored in the system database. This function compares the Customer Centrex Manager data with the switch data for the FCOS Codes entered in the Sync FCOS Code Update page.

Sync FCOS Code Delete

Use the Sync FCOS Code Delete page to remove FCOS Codes from the Customer Centrex Manager database. Once the transaction has processed successfully, the FCOS Code will no longer be available for display or assignment.

Field Descriptions:

**FCOS Code Synchronization fields:**

**Effective Date** - Display only.

**Existing Auth Group** - Specifies the existing Auth Group that the FCOS Codes will belong to. Available on Sync FCOS Code Add page only.

**New Auth Group** - Specifies the new Auth Group that the FCOS Codes will belong to. Available on Sync FCOS Code Add page only. Enter a 1-8 character alphanumeric.

**Auth Group** - Specifies the existing Auth Group the FCOS Codes belongs to. Available on Sync FCOS Code Update and Delete pages.

**FCOS** - Specifies the FCOS's that will be added, updated or deleted.

To Update or Delete synchronize a FCOS Code, select an existing FCOS Code from the drop down lists. To Add synchronize an FCOS Code select a new FCOS Code from the drop down lists.
Sync ISDN Intercom Groups

ISDN Intercom Groups synchronization is used in the Customer Centrex Manager to gather or update a Centrex customer’s predefined ISDN Intercom Group data. ISDN Intercom Groups synchronization Delete will remove an ISDN Intercom Group from the Customer Centrex Manager database (not the switch). The Sync ISDN Intercom Add and Delete functions are available only to System Administrator.

- You may schedule one Sync Add, one Sync Update or one Sync Delete transaction at a time.
- When a Sync ISDN Intercom option is selected and a transaction is pending, the Sync ISDN Intercom page will open with the existing transaction data displayed in the page.
- If there is no pending transaction, the page will display empty fields.
- The type of synchronization, add, update or delete is based on the Sync Tab selected.

Sync ISDN Intercom Groups Add

Use the Sync ISDN Intercom Groups Add page to add new ISDN Intercom Groups into the Customer Centrex Manager database. The system gathers the information from the switch and creates a record for each Group name entered in the Sync ISDN Intercom Groups Add page. Once the transaction has processed successfully, the ISDN Intercom Group names will be available for assignment.

Sync ISDN Intercom Groups Update

Use the Sync ISDN Intercom Groups Update page to update predefined ISDN Intercom group names stored in the system database. This function compares the Customer Centrex Manager data with the switch data for the ISDN Intercom Group names entered in the Sync ISDN Intercom Groups Update page.

Sync ISDN Intercom Groups Delete

Use the Sync ISDN Intercom Groups Delete page to remove ISDN Intercom Groups from the Customer Centrex Manager database. Once the transaction has processed successfully, the ISDN Intercom Groups names will no longer be available for display or assignment.

Field Descriptions:

**ISDN Intercom Group Synchronization fields:**

- **Effective Date** - Display only.
- **ISDN Intercom Group** - Specifies the ISDN Intercom Groups that will be added, updated or deleted.
  
  To Update or Delete synchronize an ISDN Intercom group, select an existing group from the drop down list. To Add synchronize an ISDN Intercom group enter a 1-8 character alphanumeric ISDN Intercom group name.

Sync Message Service System (MSS) Groups

Message Service System Groups synchronization is used in the Customer Centrex Manager to gather or update a Centrex customer’s predefined Message Service System Group data. Message Service System Groups synchronization delete will remove a Message Service System Group from the Customer Centrex Manager database (not the switch). The Sync Message Service System Add and Delete functions are available only to System Administrator.

- You may schedule one Sync Add, one Sync Update or one Sync Delete transaction at a time.
- When a Sync MSS option is selected and a transaction is pending, the Sync MSS page will open with the existing transaction data displayed in the page.
If there is no pending transaction, the page will display empty fields.
The type of synchronization, add, update or delete is based on the Sync Tab selected.

**Sync MSS Groups Add**
Use the Sync MSS Groups Add page to add new MSS Groups into the Customer Centrex Manager database. The system gathers the information from the switch and creates a record for each Group name entered in the Sync MSS Groups Add page. Once the transaction has processed successfully, the MSS group names will be available for assignment.

**Sync MSS Groups Update**
Use the Sync MSS Groups Update page to update predefined message service group names stored in the system database. This function compares the Customer Centrex Manager data with the switch data for the MSS Group names entered in the Sync MSS Groups Update page.

**Sync MSS Groups Delete**
Use the Sync MSS Groups Delete page to remove MSS Groups from the Customer Centrex Manager database. Once the transaction has processed successfully, the MSS Groups names will no longer be available for display or assignment.

**Field Descriptions:**
**Message Service Group Synchronization fields:**
- **Effective Date** - Display only.
- **Message Service Group** - Specifies the message services group that will be added, updated or deleted.
  To Update or Delete synchronize a message services group, select an existing group from the drop down list. To Add synchronize a message services group enter a 1-8 character alphanumeric.

**Sync Speed Call Group**
Speed Call Groups synchronization is used in the Customer Centrex Manager to gather a Centrex customer's shared Speed Call group data from the switching machine and to update the Centrex Management database. The Customer Centrex Manager will interrogate the 5ESS switch (verify) to gather the code block data for each Speed Call Group name a customer may have. Speed Call block data will consist of the TNs in the Speed Call Group. The Sync Speed Call Groups Add and Update functions are available only to System Administrators.

- You may schedule one Sync Add or one Sync Update transaction at a time.
- When a Sync Speed Call Groups option is selected and a transaction is pending, the Sync Speed Call Groups page will open with the existing transaction data displayed in the page.
- If there is no pending transaction, the page will display empty fields.
- The type of synchronization, add or update is based on the Sync Tab selected.

**Sync Speed Call Groups Add**
Use the Sync Speed Call Groups Add page to add new Speed Call Groups into the Customer Centrex Manager database. The system gathers the information from the switch and creates a record for each Speed Call Group entered in the Sync Speed Call Groups Add page. Once the transaction has processed successfully, the Speed Call Groups will be available for display and assignment.
Sync Speed Call Groups Update

Use the Sync Speed Call Groups Update page to update predefined Speed Call Group names stored in the system database. This function compares the Customer Centrex Manager data with the switch data for the Speed Call Group names entered in the Sync Speed Call Groups Update page.

Field Descriptions:

**Speed Call Groups Synchronization fields:**
- **Effective Date** - Display only.
- **Type** - Specifies the Speed Call Group Type, one digit or two.
- **Speed Call Name** - Specifies the Speed Call Groups that will be added, or updated.

To Update synchronize a Speed Call Group, select an existing group from the drop down list. To Add synchronize a message services group enter a 1-11 character alphanumeric.

Sync TN

TN synchronization is used in the Customer Centrex Manager to gather or update a Centrex lines attributes and feature/option data. TN synchronization delete will remove a TN from the Customer Centrex Manager database (not the switch). The Sync TN Add and Delete functions are available only to System Administrator.

- You may schedule one Sync Add, one Sync Update or one Sync Delete transaction at a time.
- When a Sync TN option is selected and a transaction is pending, the Sync TN page will open with the existing transaction data displayed in the page.
- If there is no pending transaction, the page will display empty fields.
- The type of synchronization, add, update or delete is based on the Sync Tab selected

Sync TN Add

Use the Sync TN Add page to add new lines into the Customer Centrex Manager database. The system gathers the line information from the switch and creates a record for each telephone number entered in the Sync TN Add page. Once the transaction has processed successfully, the telephone numbers will be available for display in the Station List and Station pages.

Sync TN Update

This function compares the system data with the switch data for the telephone numbers entered in the Sync TN Update page. This function is used when a feature or functionality update has been performed on the line by your LEC without using the Centrex Management application. Use the Sync TN Update page to update database records for existing telephone numbers.

Sync TN Delete

Use the Sync TN delete page to remove lines from the Customer Centrex Manager database. Once the transaction has processed successfully, the telephone numbers will no longer be available for display in the Station List and Station windows.

Field Descriptions:

- **Effective Date** - Display only.
- **NPA** - Number Plan Area Code. The NPA can be a minimum of 3 digits and a maximum of 7 digits in length. Select an NPA from the drop-down list.
Note: This field will only be visible for 10+ digit Centrex support. If it is not visible, your LEC can determine if this option is available to you.

**TNs and TN Ranges** - Specifies the telephone numbers that will be added or updated based on the available switch data. Up to 45 pairs of telephone numbers may be entered.

- To synchronize a range of telephone numbers, type the lowest number in the range in the first column field and the highest number in the second (e.g., 5551000 to 5551050).
- To synchronize non-sequential numbers, only use the first field in each pairing.

**DMS 100 Move/Sync**

The Sync Authorization (Auth) Codes page is used to manipulate authorization code information that is stored in the system databases. You can add authorization codes from the switching machine to the database; delete authorization codes from the database, and update the authorization code information in the database with the current information in the switch. The Authorization Code feature allows a customer to define sets of both feature and facility dialing privileges, to associate an authorization code with each set, and to use these authorization codes to restrict the dialing privileges to authorized personnel. You can manipulate authorization codes individually or in ranges. To specify the authorization codes individually, simply enter values in the Begin Authcode fields. To specify ranges of authorization codes, enter values in both the Begin Authcode and End Authcode fields. Select the Load All Authcodes field, to load all authorization codes. The Sync Auth Code Add and Delete functions are available only to System Administrator.

- You may schedule one Sync Add, one Sync Update or one Sync Delete transaction at a time.
- When a Sync Auth Code option is selected and a transaction is pending, the Sync Authcode page will open with the existing transaction data displayed in the page.
- If there is no pending transaction, the page will display empty fields.
The type of synchronization, add, update or delete is based on the Sync Tab selected.

**Sync Authcode Add**
Use the Sync Auth Codes Add page to add new Auth Codes into the Customer Centrex Manager database. The system gathers the information from the switch and creates a record for each Auth Code entered in the Sync Auth Codes Add page. Once the transaction has processed successfully, the Auth Codes will be available for assignment.

**Sync Authcode Update**
Use the Sync Auth Codes Update page to update predefined Auth Code stored in the system database. This function compares the Customer Centrex Manager data with the switch data for the Auth Codes entered in the Sync Auth Codes Update page.

**Sync Authcode Delete**
Use the Sync Auth Codes Delete page to remove Auth Codes from the Customer Centrex Manager database. Once the transaction has processed successfully, the Auth Codes names will no longer be available for display or assignment.

**Field Descriptions:**

**Auth Code Synchronization fields:**
- **Effective Date** - Display only.
- **Load All Authcodes** - Select this option to load all authorization codes assigned to a customer group from the switching machine. When you choose this option, the Begin Authcode and End Authcode fields must be left blank.
- **Begin Authcode** - The Begin Authcode field allows you to specify a particular Authorization code that you want to add, update, or delete. This code is from 2 to 10 digits. However, the length must match the length specified on the RATH Report. To specify an individual Auth code enter the Auth code in this field, leaving the End Authcode field blank. To specify a span of Auth codes, make entries in both this field and the End Authcode field.
- **End Authcode** - Specifies the Auth Codes that will be added, updated or deleted.

To synchronize an Auth Code, enter a 2 - 10 numeric Auth Code.

**Sync COS Mapping Add/Update**
The COS Mapping Synchronization dialog box is used to **Add** new NCOS codes into the database or **Update** existing database code parameters with the settings that are currently assigned at the switch.
- The type of synchronization, add or update, is based on the command option selected from the Network Speed Calling List window menu bar.
- Customer Centrex Manager allows one pending occurrence of an add transaction and one pending occurrence of an update transaction.
- If a COS Mapping Sync option is selected and transaction is pending, the COS Mapping dialog box will open with the existing transaction data displayed in the window.
- If there is no pending transaction, the window will display empty fields.

**Field Descriptions:**
- **Effective Date** - Display only.
- **COS Mapping Name** - Specifies the NCOS name that needs to be synchronized with the switch. Type a 1 - 16 character alphanumeric NCOS name in this field. You may synchronize up to 60 codes per add or update transaction.
The name entered must match a predefined value created by your Local Exchange Carrier. If you are unsure of what names are already in use, open the NCOS Administration List window. You can also generate a RCOS Report to obtain a listing of all existing NCOS codes. To obtain new NCOS codes, contact your LEC System Administrator.

Sync Meet-Me Conference Schedule

Sync Meet-Me Conference is used to add/update all of a customer group's meet-me conference data from the switching machine to the Customer Centrex Manager database. After selecting the Sync Meet-me Conference menu item the user will be presented with the Meet-me Conference Schedule page. If a request is pending for Meet-Me Conference it will be noted on the Meet-me Conference Schedule page.

Field Descriptions:

Request Name - A default name (SYNC_MMC) will be assigned if a unique identifier is not entered. To assign a name, type a unique value in the text box.

Scheduling Options

Select the appropriate radio button to determine how your request will be processed. Only one can be selected.

Under Construction - Saves the request but does not schedule it for processing. This option allows you to save a transaction in progress and complete the entries at a later date. Once you have completed your transaction activity, a priority or pending option must be specified to have the request processed through the switch.

Delete Request - Selecting this option cancels an existing pending request. A request with a processing or completed status, cannot be canceled.

Priority - Allows the transaction to process immediately. Works in conjunction with switch availability. The number of priority transactions that may be requested per day is determined by your LEC System Administrator.

Pending - Schedules a request for a future date. Used in conjunction with the pending date field. Requests are transmitted to the switch on the designated effective date. The transfer time is determined by your Local Exchange Carrier.

Note: If a feature or field has a pending value assigned, the current value is still stored in the Customer Centrex Manager database until the transaction is sent to the switch. This allows you to cancel a pending transaction or use the Delete Request option to undo a pending request.

Calendar Icon - Displays a calendar. Clicking on a date will populate the Pending Date field. Used if the Pending option is selected.

(Pending Date) - The date on which your pending transaction will be processed. Used if the Pending option is selected.

Type a unique value in the text box or use the Calendar Icon to select a date.

Sync Network Speed Calling
Sync Network Speed Calling is used to gather a customer group's network speed call data from the switching machine into the system database. For this page, you need to specify either a single network speed call name for loading or all speed call names assigned to this customer.

**Field Descriptions:**

**Network Speed Calling Synchronization fields:**
- **Effective Date** - Display Only.
- **All Speed Call Names** - The All Speed Call Names check box is used to load all speed call names assigned to this Centrex customer. When you choose this option, you must leave the Speed Call Name field blank.
- **Speed Call Name** - The Speed Call Name field is used to load an individual speed call name assigned to this customer.

**Sync Preset Conference Schedule**

Sync Preset Conference is used to add/update all of a customer group's Preset conference data from the switching machine to the Customer Centrex Manager database. After selecting the Sync Preset Conference menu item the user shall be presented with the Preset Conference Schedule page. If a request is pending for Preset Conference it will be noted on the Preset Conference Schedule page.

**Field Descriptions:**
- **Request Name** - A default name (SYNC_PSC) will be assigned if a unique identifier is not entered. To assign a name, type a unique value in the text box.

**Scheduling Options**

Select the appropriate radio button to determine how your request will be processed. Only one can be selected.

- **Under Construction** - Saves the request but does not schedule it for processing. This option allows you to save a transaction in progress and complete the entries at a later date. Once you have completed your transaction activity, a priority or pending option must be specified to have the request processed through the switch.

- **Delete Request** - Selecting this option cancels an existing pending request. A request with a processing or completed status, cannot be canceled.

- **Priority** - Allows the transaction to process immediately. Works in conjunction with switch availability. The number of priority transactions that may be requested per day is determined by your LEC System Administrator.

- **Pending** - Schedules a request for a future date. Used in conjunction with the pending date field. Requests are transmitted to the switch on the designated effective date. The transfer time is determined by your Local Exchange Carrier.

**Note:** If a feature or field has a pending value assigned, the current value is still stored in the Customer Centrex Manager database until the transaction is sent to the switch. This allows you to cancel a pending transaction or use the Delete Request option to undo a pending request.

- **Calendar Icon** - Displays a calendar. Clicking on a date will populate the Pending Date field. Used if the Pending option is selected.
(Pending Date) - The date on which your pending transaction will be processed. Used if the Pending option is selected.
Type a unique value in the text box or use the Calendar Icon to select a date.

Sync TN

TN synchronization is used in the Customer Centrex Manager to gather or update a centrex lines attributes and feature/option data. TN synchronization delete will remove a TN from the Customer Centrex Manager database (not the switch). The Sync TN Add and Delete functions are available only to System Administrator.

- You may schedule one Sync Add, one Sync Update or one Sync Delete transaction at a time.
- When a Sync TN option is selected and a transaction is pending, the Sync TN page will open with the existing transaction data displayed in the page.
- If there is no pending transaction, the page will display empty fields.
- The type of synchronization, add, update or delete is based on the Sync Tab selected.

Sync TN Add

Use the Sync TN Add page to add new lines into the Customer Centrex Manager database. The system gathers the line information from the switch and creates a record for each telephone number entered in the Sync TN Add page. Once the transaction has processed successfully, the telephone numbers will be available for display in the Station List and Station pages.

Sync TN Update

This function compares the system data with the switch data for the telephone numbers entered in the Sync TN Update page. This function is used when a feature or functionality update has been performed on the line by your LEC without using the Centrex Management application. Use the Sync TN Update page to update database records for existing telephone numbers.

Sync TN Delete

Use the Sync TN delete page to remove lines from the Customer Centrex Manager database. Once the transaction has processed successfully, the telephone numbers will no longer be available for display in the Station List and Station windows.

Field Descriptions:

- **Effective Date** - Display only.
- **NPA** - Number Plan Area Code. The NPA can be a minimum of 3 digits and a maximum of 7 digits in length. Select an NPA from the drop-down list.

  Note: This field will only be visible for 10+ digit centrex support. If it is not visible, your LEC can determine if this option is available to you.

- **TNs and TN Ranges** - Specifies the telephone numbers that will be added or updated based on the available switch data. Up to 45 pairs of telephone numbers may be entered.
  - To synchronize a range of telephone numbers, type the lowest number in the range in the first column field and the highest number in the second (e.g., 5551000 to 5551050).
  - To synchronize non-sequential numbers, only use the first field in each pairing.
Station Management

Remember that you can always find information about the page you are on by clicking on the Help tab or button.

![Station Management TN](image)

Figure 12 Station Management TN

Station Information

**Open a Single Station.**
The Open Station page is displayed by default.

1. **NPA field** - Select an NPA from the drop-down list.
   
   **Note:** This field will only be visible for 10+ digit centrex support. If it is not visible, your Local Exchange Carrier can determine if this option is available to you.

2. **Telephone Number** field - Enter the **Telephone Number** you want displayed. (Enter 3 to 7 digits with no special characters. Example (2250001)

3. Click **OK**.

**View a List of Stations.**

1. Click the **Station List** tab.
   
   **Note:** The station list will be pre-populated with TNs based on the criteria defined in the user Preferences. The Preferences page is located on the System Tab.

2. Click the **View** menu located along the top bar of the Station List page to change the list display criteria.

   The following display options are available:
   
   - **All TNs** - Displays all TN types in the Station List.
   - **BSET** - Changes the type of TNs to be viewed in the Station List to Business Sets.
ISDN - Changes the type of TNs to be viewed in the Station List to ISDN Sets.
NISDN - Changes the type of TNs to be viewed in the Station List to National ISDN Sets.
SLS - Displays all TNs defined as a Single Line Set that are associated with the active custid.
TN Range - Opens the Find TN Range dialog box. Use this option to display all TNs within the range specified.
Unscheduled Change - Displays all TNs with pending changes that have not been scheduled and are still Under Construction.
Virtual TNs - Changes the type of TNs to be viewed to Virtual TNs.

3. Click the desired View option.
4. To open a station from the station list page, move the cursor over the station list until the desired TN is highlighted. Click anywhere in the highlighted row.

Field Descriptions:
- List as Of: Display only.
- Sort By: Icon and drop-down list. Use the default down-arrow to sort by ascending order. Click on the icon to change to the up arrow for descending order. Use the drop-down list to select the column header to sort by.
- Type: The set type (i.e., BSET, SLS)
- NPA: Number Plan Area Code. The NPA can be a minimum of 3 digits and a maximum of 7 digits in length. Select an NPA from the drop-down list.

Note: This field will only be visible for 10+ digit Centrex support. If it is not visible, your Local Exchange Carrier can determine if this option is available to you.

- TN: The primary telephone number. The TN can be 3 to 7 digits with no special characters.
- Name: The name that is assigned to the primary telephone number. This is an optional field and may not contain any data.
- Status: Status for the telephone number.
- Changed: The last date that telephone number showed activity.
- Last User: The last logon to make a change to the telephone number. Possible Values
- Organization: The organization identifier assigned to the telephone number. This is an optional field and may not contain any data.
- Location: The location where the primary line is located. This is an optional field and may not contain any data.
- Model: The model number for the specific set. This is an optional field and may not contain any data.
- Jack: The id number for the jack location. This is an optional field and may not contain any data.

Menu Descriptions:
- Stations Menu:
  - Print: Opens the browser's print page for printing selected station related information.
  - Close: Closes the Station List page.
- Object Menu:
  - Move: Opens the Moves Request page.
- View Menu:
  - Refresh: Refreshes the objects displayed in the list. In particular, the Status column is updated to reflect if there are any pending changes to the TN.
  - All TNs: Displays all TN types in the Station List.
  - BSET: Changes the type of TNs to be viewed in the Station List to Business Sets.
  - ISDN: Changes the type of TNs to be viewed in the Station List to ISDN Sets.
  - NISDN: Changes the type of TNs to be viewed in the Station List to National ISDN Sets.
  - SLS: Changes the type of TNs to be viewed in the Station List to Single Line Sets.
**TN Range** - Opens the Find TN Range dialog box. Use this option to display all TNs within the range specified.

**Unscheduled Change** - Changes the type of TNs to be viewed in the Station List to all TNs that are still under construction and have not yet been scheduled.

**Virtual TNs** - Changes the type of TNs to be viewed to Virtual TNs.

**Help Menu:**
Help on Station Lists - Opens help for Station Information.

**General Items**

**System Admin Mail**

![Image of System Admin Mail Page]

Figure 13 System Admin Mail Page

The Mail List page is used to send new mail or read mail you have received from another user or your LEC System Administrator.

- Click on any row to display the mail message.

**Field Descriptions:**

- **Sort By:** - Icon and drop-down list. Use the default down-arrow to sort by ascending order. Click on the icon to change to the up arrow for descending order. Use the drop-down list to select the column header to sort by.
- **Num** - The sequential list numbers associated with incoming mail. Whether the most recent mail is viewed first or last is determined by your LEC System Administrator.
- **From** - The mail originator's Login I.D. Mail may also be generated by the Customer Centrex Manager. If so, the associated I.D. will be displayed.
- **Subject** - A brief description of the mail contents.
- **Date/Time** - The date and time the mail was sent.
Delete - Check this box to mark the message for deletion.

Menu Descriptions:

Mail:
- **Print** - Opens the browser's print page for printing selected materials.
- **Close** - Closes the System Admin Mail page.

Object:
- **New Message** - Opens the New Message page.
- **Delete Message** - Used to delete one or more mail entries from the list. This option is enabled when one or more rows are checked.

Help:
- Displays the System Admin Mail help topic.

New Mail Message Description

You can create and send new mail messages using the Create New Mail Message function. Eligible addresses are predetermined by your LEC System Administrator.

**Note:** Customer Centrex Manager mail is used to communicate between Customer Centrex Manager users and administrators.

Field Descriptions:

- **Date** - Today's date. Read only.
- **Subject** - Provide a brief description of the mail message content. This is an optional field. Enter the subject in the text box.
- **To** - The Login I.D. to which the mail will be sent. You can select multiple recipients by selecting all the IDs you want to send the mail to.
- **(Text Area)** - Type the mail message data in this free-form text field.

Command Buttons:

- **Print** - Opens the browser's print page for printing selected data.
- **Send Mail** - Command button that initiates the send mail transaction. Once data has been entered in the New Mail Message dialog box, click on the Send Mail button to process the transaction.
- **Cancel** - Closes the New Mail Message Description page without sending the message or saving any changes.
- **Help** - Opens the New Mail Message Description help topic.

Read Mail Message Description

You can read new mail, reply to the sender, print text, and delete messages using the Read Mail Message function.

Customer Centrex Manager mail is used to communicate between Customer Centrex Manager users and administrators.

Field Descriptions:

- **From** - The mail originator's Login I.D. Mail may also be generated by the Customer Centrex Manager. If so the associated I.D. will be displayed.
- **Subject** - Provides a brief description of the mail message content.
**Date/Time** - The date and time the mail was sent.
**Text Area** - The mail message data is displayed in this text field.

**Command Buttons:**
- **Delete** - Command button that deletes the current message. All reference to the mail message will be removed from the list. The next mail message will display in the open window.
- **Reply** - Opens the New Mail Message page. The Subject and To fields will be populated.
- **Reply with History** - Use this button to include the text of the incoming message with your response.
- **Print** - Opens the browser's print page for printing group related data.
- **OK** - Closes the Read Mail Message Description help topic.
- **Help** - Opens the Read Mail Message Description help topic.

**Read Mail Message Description**

You can read new mail, reply to the sender, print text, and delete messages using the Read Mail Message function.
Customer Centrex Manager mail is used to communicate between Customer Centrex Manager users and administrators.

**Field Descriptions:**
- **From** - The mail originator's Login I.D. Mail may also be generated by the Customer Centrex Manager. If so the associated I.D. will be displayed.
- **Subject** - Provides a brief description of the mail message content.
- **Date/Time** - The date and time the mail was sent.
- **Text Area** - The mail message data is displayed in this text field.

**Command Buttons:**
- **Delete** - Command button that deletes the current message. All reference to the mail message will be removed from the list. The next mail message will display in the open window.
- **Reply** - Opens the New Mail Message page. The Subject and To fields will be populated.
- **Reply with History** - Use this button to include the text of the incoming message with your response.
- **Print** - Opens the browser's print page for printing group related data.
- **OK** - Closes the Read Mail Message Description help topic.
- **Help** - Opens the Read Mail Message Description help topic.
Requests

Figure 14 Requests Page

Rename Request
Use the Rename Request function to change the unique identifier given to a pending request.

Field Descriptions:
Current Name - Display only field that shows the existing request name.
New Name - The identifier you want to assign to the request.
Type the new name in the text box.
Currently Used Names - Scrollable list of request names that are currently in use.

Request List Description
The Request List window is used to review pending transaction information and verify processing of completed requests.

View a Request Message
1. Locate the desired completed request in the list.
2. Click anywhere in the request row. The Request Message page is displayed.

Rename a Request
1. Locate the desired Request in the list.
2. Click on the Rename column button to indicate the request message to be renamed.
3. The Rename Request page is displayed.

Field Descriptions:

Sort By: - Icon and drop-down list. Click on the up arrow to sort by ascending order. Click on the down arrow to change to descending order. Use the drop-down list to select the column header to sort by.

Note: List data is not automatically updated. Use the View>Refresh option to update the information displayed.

Delete All - Button. Pressing this button deletes all requests whose status is "Completed".
Type - Display only. Set type. View Result Field Definitions.
Name - The name that was assigned to the request.
Status - The current status of the request. Valid choices are Pending, Processing, Test Run, and Completed.
Effective - Display only field that contains the scheduled request date. This field will display "none" if there is no pending modification request.
Result - Transaction processing result. View Result Field Definitions.
Date Submitted - The date the transaction was created (scheduled).
User Name - The person who submitted the request. If the request was modified, this field contains the last person to modify the request.
Delete - Check this box to mark the request for deletion.
Rename - Used to rename a request. Click the button in the desired request row. The Rename Request page is opened.

Note: All modifications to pending transactions must be performed in the originating area (e.g., Station window, Modify Authorization Code dialog box, etc.).

Menu Descriptions:

Requests:
Print - Prints data using the browser's print capability.
Close - Closes the Request List page.

Object:
Delete Completed Request - Used to delete one or more Request entries from the list.

View:
Refresh - Refreshes the objects displayed in the Request List. Use this option to update the list so that it includes all requests created or updated since the last time the page was opened or refreshed.
All Requests - Displays all request types.
Selected Request Types - Opens the Select Request Types page, enabling you to specify the types of requests that should be listed in the window.
Failed Request Only - Displays only Failed requests.

Help:
Help on Requests - Displays the Request List Description help topic.

Type Field Definitions
STA - request created on a Station screen
BULK - request created in a Bulk group page
GRP - request created in a Group page
MOVE - request created in the Move page
SYNCMMC - request created in the Sync Meet-Me Conference dialog box
SYNCAUTH - request created in the Sync Auth Code dialog box
SYNCCOS - request created in the Sync Class of Service (COS) dialog box
SYNCPSC - request created in the Sync Preset Conference dialog box
SYNC - request created in the TN Sync dialog box
AUTH - request created in the Modify Authorization Code dialog box
MCNF - request created in the Meet-Me Conference page
PCNF - request created in the Preset Conference page
NSC - request created in the Network Speed Calling page
NCOS - request created in the Network Class of Service page
COS - request created in the COS Mapping Sync page
ADD - request created in the Add Stations function
OTH - request created using another function

Results Field Definitions
PEND - transaction pending (may be opened and edited)
LOCK - transaction is locked for processing
PASS - transaction has completed successfully
FAIL - transaction has completed but failed during processing
PART - transaction has completed and was partially successful

Request Message Description

Once request processing is complete, the Customer Centrex Manager generates a message listing the status of your transaction.

Generic information is provided for successful transactions.
A failed or partially failed transaction will contain information detailing the items that could not be processed by the switch.

Note: Use the Request Preferences folder to establish the message types that you want to review.
You can view all messages relating to your requests or have the system store only failed request messages. You can also determine what types of messages are retained if the LEC System Administrator generated the request.

Schedule Request Page
The Schedule Request Page is used to determine how your transaction will be processed, to cancel a pending transaction, or to save work in progress.

Field Descriptions:

Request Name - A unique name that allows you to identify the request in the Request List page. A default name will be assigned if a unique identifier is not selected.
To assign a name, type a unique value in the text box.
Existing Requests: - Drop-down list displaying the names of any existing requests.

Test Run Only - (Enabled only for Bulk Group requests.) Check this box to generate an RBEX report without sending your transaction to the switch. This allows you to see how your Bulk request will be processed for each telephone number. If there are conflicts, you can make the appropriate changes and then schedule the transaction for switch processing.
Note: If the Test Run Only option is selected, you must schedule your request as a priority. You must then reschedule your request once you have reviewed the RBEX report and made any transaction modifications. Make sure that the Test Run Only check box is not checked or the transaction will not be sent to the switch.

Scheduling Options
Select the appropriate radio button to determine how your request will be processed. Only one can be selected.

Under Construction - Saves the request but does not schedule it for processing. This option allows you to save a transaction in progress and complete the entries at a later date. Once you have completed your transaction activity, a priority or pending option must be specified to have the request processed through the switch.

Delete Request - Selecting this option cancels an existing pending request. A request with a processing or completed status, cannot be canceled.

Priority - Allows the transaction to process immediately. Works in conjunction with switch availability. The number of priority transactions that may be requested per day is determined by your LEC System Administrator.

Pending - Schedules a request for a future date. Used in conjunction with the pending date field. Requests are transmitted to the switch on the designated effective date. The transfer time is determined by your Local Exchange Carrier.

Note: If a feature or field has a pending value assigned, the current value is still stored in the Customer Centrex Manager database until the transaction is sent to the switch. This allows you to cancel a pending transaction or use the Delete Request option to undo a pending request.

Calendar Icon - Displays a calendar. Clicking on a date will populate the Pending Date field. Used if the Pending option is selected.

(Pending Date) - The date on which your pending transaction will be processed. Used if the Pending option is selected.

Type a unique value in the text box or use the Calendar Icon to select a date.

Note: If a scheduling conflict exists, a message will appear directing you to select a new date. If you want to have the current transaction processed on the selected date, reschedule the original transaction, then schedule your current activity.

Select Request Types Description
This dialog box is used to specify what type of requests you want to run. It is displayed if you select the menu option View | Selected Request Types from the Request List window.

Note: Multiple selections are allowed.

Field descriptions:

Station Management

Bulks - Check this box to display any requests that were generated using the Bulk functions.
Groups - Check this box to display any requests that were generated using the Group functions.
Moves - Check this box to display any requests that were generated using the Move functions.
Stations - Check this box to display any requests that were generated using the Station functions.

Administration
Auth Codes - Check this box to display any requests that were generated using the Authorization Code functions.
Conferencing - Check this box to display any requests that were generated using the Conferencing functions.
Network Management - Check this box to display any requests that were generated using the Network Management functions.
Network Speed Call - Check this box to display any requests that were generated using the Network Speed Call functions.
Syncs - Check this box to display any requests that were generated using the Synchronization functions.

Reports

Reports Common to 5ESS and DMS 100

RCFS - Customer Field Search Report
The Customer Field Search report gives you the ability to create special reports that search the database for information you need. You can use the report to generate a list of the particularly telephone numbers you want, depending on the search criteria you set. You can search the database for records that match a single key or a set of keys, and displays the results with custom headings that identify the output.

- Use the RCFS Run Report dialog box to determine what information will be gathered and displayed.
- Once you have defined the report you want, it is processed in the background and must be retrieved.
- Use the Reports List - Completed folder to view your report.
- Save and Load Query options allow you to store a common query and use it at a later date.

RCIS Report
RCIS report provides status for telephone numbers that are being entered into the system via the Chip-In function.

- The main page area contains the data requested.
- A graphic representation of the report data is displayed at the top of the page.

RCIS Report fields: (Display Only)
Custid - The custid where the numbers will be assigned.
TN - The TNs that are being or have been added to the associated custid.
Status - The processing status of the associated TN.
  Pending - TN is waiting to be processed.
  Processing - TN is currently being processed.
  Completed - TN has been processed and loaded successfully into the system database.
  Failed - TN was processed but could not be loaded successfully due to switch or database failures.
Date Entered - The date and time the TN was entered into the TN/Custid Mapping table.
Date Processed - The date and time the chip-in transaction was either completed or failed, depending on the value in the Status field.
Note: If you wish to retain this information, you must use one of the options in the File menu or the Print command button at the bottom of the browser window. When you close this report page the data will be lost. A new query will find any items matching the search request at the current time. It may be different from the previous report display.

RCPU - Call Pickup Groups Report
The Call Pickup Groups report presents group information about one Call Pickup Group or all your Call Pickup Groups. You can also request a list of all your Call Pickup Group numbers that are assigned to telephone numbers or all unassigned Call Pickup Group numbers that are available to you.
- Use the RCPU Run Report dialog box to determine what information will be gathered and displayed.
- Once you have defined the report you want, it is processed in the background and must be retrieved.
- Use the Reports List - Completed folder to view your report.

RCUS - Customized Reports
Customized reports present groups information about various data contained in the database. The report design and the fields that are queried are determined by your LEC.
- Use the RCUS Run Report dialog box to determine what information will be gathered and displayed.
- Once you have defined the report you want, it is processed in the background and must be retrieved.
- Use the Reports List - Completed folder to view your report.

RDIR - Directory Listing Report
The Directory Listing report allows you to query directory information on a name, location, organization, or telephone number basis.
- Use the RDIR Run Report dialog box to determine what information will be gathered and displayed.
- Once you have defined the report you want, it is processed in the background and must be retrieved.
- Use the Reports List - Completed folder to view your report.

RDNH - Directory Number Hunt Groups
The Directory Number Hunt Groups Report gives you information about one Directory Number Hunt Group or all Directory Number Hunt Groups in your database. You can also request a list of all the Hunt Group Pilot telephone numbers in your database.
- Use the RDNH Run Report dialog box to determine what information will be gathered and displayed.
- Once you have defined the report you want, it is processed in the background and must be retrieved.
- Use the Reports List - Completed folder to view your report.

RFLD - Field Names Report
The RFLD - Field Names report gives you a listing of all the system fields that may be queried. The report output displays the field name, description and possible values for each searchable field in the database.
This report is useful when it is generated, printed, and used as a reference for entering field searches in the Bulk Group Members view or RCFS Run Report dialog box.

- This report has no associated parameters.
- Once you have requested the report, it is processed in the background and must be retrieved.
- Use the Reports List - Completed folder to view your report.

**RGIC - Group Intercom Report**
The Group Intercom report gives you information about one or all of the intercom groups in the database. You can also request a list of all your group intercom names.

- Use the RGIC Run Report dialog box to determine what information will be gathered and displayed.
- Once you have defined the report you want, it is processed in the background and must be retrieved.
- Use the Reports List - Completed folder to view your report.

**RLIM - Limits and Feature Counts Report**
The Limits and Feature Counts Report lists the number of feature changes and limits that have been predetermined for you and also informs you how much of your limit has been used or is pending usage.

- Use the RLIM Run Report dialog box to determine what information will be gathered and displayed.
- Once you have defined the report you want, it is processed in the background and must be retrieved.
- Use the Reports List - Completed folder to view your report.

**RPND Run Report Dialog Box**
The Pending Changes All report gives you information about all the outstanding pending requests for a given date or a range of dates. You have the option of excluding bulk pending records from this report.

- Use the RPND Run Report dialog box to determine what information will be gathered and displayed.
- Once you have defined the report you want, it is processed in the background and must be retrieved.
- Use the Reports List - Completed folder to view your report.

**RSCG - Shared Speed Call Groups Report**
The Shared Speed Call Groups report gives you information about one Speed Call Group or all Speed Call Groups that you have. You can also request if the report is to be for 1 or 2-digit Speed Call Groups.

- Use the RSCG Run Report dialog box to determine what information will be gathered and displayed.
- Once you have defined the report you want, it is processed in the background and must be retrieved.
- Use the Reports List - Completed folder to view your report.

**RSTN - Station Configurations Report**
The Station Configurations report provides information for Single Line Sets and ISDN sets, for a single telephone number, or a range of telephone numbers. You can produce reports for any or all of these items including the specific parameters you select.

- Use the RSTN Run Report dialog box to determine what information will be gathered and displayed.
- Once you have defined the report you want, it is processed in the background and must be retrieved.
Use the Reports List - Completed folder to view your report.

**RUID - Unidentified TNs Report**
The RUID report provides a list of unidentified TNS that are being entered into the system via the Chip-In function. These TNs must be associated with a Custid to complete processing. The main page area contains the available data.

**RUID Report fields: (Display Only)**
- **TN** - The TNs that have been retrieved from the MARCH system but do not have a Custid association.
- **Date Received** - The date the TN was retrieved for processing.
- **Centrex Group** - The Centrex Group identified in the order.
- **Exchange Key** - The switch exchange key associated with the TN.

**Note:** If you wish to retain this information, you must use one of the options in the File menu. When you close this report page the data will be lost. A new query will find any items matching the search request at the current time. It may be different from the previous report display.

**5ESS Unique Reports**

**RARO - ARS Route Order Report**
The ARS Route Order Report (RARO) provides the user information regarding one or all of their route list chains and route parameters. The report will list both the current and pending views of all top routes and all routes for a specific MC Route Index.

- Once you have defined the report you want, it is processed in the background and must be retrieved.
- Use the Reports List - Completed folder to view your report.

**RARS - ARS Pattern Report**
The ARS Pattern Report (RARS) provides the user information regarding ARS pattern groups and Screening Index views of ARS Groups. The first part of the report contains the ARS Group with it's current and pending ARS Pattern information. The second portion lists the ARS Screening Index view(s) along with the pattern group treatments. There is no pending information for the ARS Screening Index section. The report content is determined by the user entries in the RARS Identifier page.

- Once you have defined the report you want, it is processed in the background and must be retrieved.
- Use the Reports List - Completed folder to view your report.

**RCAI - Call Appearance Intercom Report**
The Call Appearance Intercom report gives you information about one or all of the call appearance intercom groups in the database. You can also request a list of all your group intercom names.

- Use the RCAI Run Report dialog box to determine what information will be gathered and displayed.
- Once you have defined the report you want, it is processed in the background and must be retrieved.
- Use the Reports List - Completed folder to view your report.
RCFG - Configuration Groups Report
The Configuration Groups report gives you information about one or all of the configuration groups that you can access. You can also request a list of all your configuration groups, with an English description of each group.
› Use the RCFG Run Report dialog box to determine what information will be gathered and displayed.
› Once you have defined the report you want, it is processed in the background and must be retrieved.
› Use the Reports List - Completed folder to view your report.

RLCC - Line Class Code Report
The Line Class Report lists the available line class codes along with a description. You do not have to enter any parameters in a report dialog box to produce this report. To retrieve a report, go to the Reports List, Completed Reports tab, and click on RLCC.
› Once you've selected the RLCC report, your request will be generated. There is no additional information required.
› Once you have defined the report you want, it is processed in the background and must be retrieved.
› Use the Reports List - Completed folder to view your report.

RMSS - Message Service System Report
The Message Service report gives you information about one or all of the message service system groups that you can access. You can also request a listing of all your MSS Group names - this report gives you the option of seeing groups according to whether they are Basic or Deluxe service.
› Use the RMSS Run Report dialog box to determine what information will be gathered and displayed.
› Once you have defined the report you want, it is processed in the background and must be retrieved.
› Use the Reports List - Completed folder to view your report.

DMS 100 Unique Reports

RATH - Authorization Codes Report
The Authorization Codes report gives you information about authorization groups and codes. You can obtain detailed information about a single Authorization Code, all Authorization Codes, or all Authorization Codes with a given main or alternate Feature Class Of Service (FCOS). You can also produce a listing of all valid Authorization Groups.
› Use the RATH Run Report dialog box to determine what information will be gathered and displayed.
› Once you have defined the report you want, it is processed in the background and must be retrieved.
› Use the Reports List - Completed folder to view your report.

RCOS - NCOS Codes Report
The NCOS Codes Report displays the active custidâ€™s assigned NCOS codes and their descriptions.
› This report has no associated parameters.
› Once you have requested the report, it is processed in the background and must be retrieved.
› Use the Reports List - Completed folder to view your report.
RMDN-MADN Groups Report
The MADN Groups report provides MADN information based on the RMDN - MADN Groups dialog box settings. The MADN Type and SCA Attributes are included in this report, as are all primary and secondary appearances.

- Use the RMDN Run Report dialog box to determine what information will be gathered and displayed.
- Once you have defined the report you want, it is processed in the background and must be retrieved.
- Use the Reports List - Completed folder to view your report.

RNCS - NCOS Configurations Report
The NCOS Configurations Report gives you the current and pending status associated with one NCOS code or all NCOS Code record(s) assigned to you. You can also request a report on the current and pending status of all NCOS Codes that have a specific NCOS Code option assignment.

- Use the RNCS Run Report dialog box to determine what information will be gathered and displayed.
- Once you have defined the report you want, it is processed in the background and must be retrieved.
- Use the Reports List - Completed folder to view your report.

RNSC - Network Speed Calling Report
The RNSC Network Speed Calling report provides Speed Call information based on the RNSC Network Speed Calling dialog box settings.

- Use the RNSC Run Report dialog box to determine what information will be gathered and displayed.
- Once you have defined the report you want, it is processed in the background and must be retrieved.
- Use the Reports List - Completed folder to view your report.
# Appendix 1 Table of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CCM Home Page</td>
<td>7</td>
</tr>
<tr>
<td>2</td>
<td>CCM logon screen</td>
<td>8</td>
</tr>
<tr>
<td>3</td>
<td>CCM Welcome Banner</td>
<td>8</td>
</tr>
<tr>
<td>4</td>
<td>Password Change Screen</td>
<td>9</td>
</tr>
<tr>
<td>5</td>
<td>Help Menu Index View</td>
<td>10</td>
</tr>
<tr>
<td>6</td>
<td>Help Menu Contents View</td>
<td>11</td>
</tr>
<tr>
<td>7</td>
<td>Main Tab</td>
<td>11</td>
</tr>
<tr>
<td>8</td>
<td>System Tab</td>
<td>13</td>
</tr>
<tr>
<td>9</td>
<td>System Tab – Preferences</td>
<td>15</td>
</tr>
<tr>
<td>10</td>
<td>5ESS Move/Sync Tab</td>
<td>18</td>
</tr>
<tr>
<td>11</td>
<td>DMS 100 Move/Sync Tab</td>
<td>25</td>
</tr>
<tr>
<td>12</td>
<td>Station Management TN</td>
<td>30</td>
</tr>
<tr>
<td>13</td>
<td>System Admin Mail Page</td>
<td>32</td>
</tr>
<tr>
<td>14</td>
<td>Requests Page</td>
<td>35</td>
</tr>
</tbody>
</table>
Appendix 2 Features

My Features
You may not have all the features listed here. What features you have available are governed by the agreement with your company and Qwest. In addition feature availability is controlled by the type of set and the type of line in use.

5ESS Feature Description

A
- ACB - The Automatic Call Back (ACB) allows a customer to contact parties they have been unable to reach or to continue an interrupted conversation.
- ACBC - Automatic Callback Calling (ACBC) allows an SLS or ISDN telephone number to dial an activation code and be called back automatically when the called station becomes idle.
- ACO - The Additional Call Offering (ACO) feature notifies an ISDN user that a call is attempting to terminate on their line when that line is busy. While ACO can be assigned to both voice and circuit switched data channels, you may control only the voice portion through Centrex Management.
- ACRS - Auto Customer Station Rearrangement (ACSR) is an ISDN feature that enables you to relocate terminal equipment and keep the primary directory number, features, group membership and restrictions, without requiring a service order.
- AR - The Automatic Recall (AR) option allows a customer to place a call to the last station that called the customer without having to know the telephone number of that call.
- ARS - Automatic Route Selection allows outgoing call routes to be hunted in a different order then that allowed by the standard programmed office route selection. You can direct calls from large business customers to the most available preferred route.
- AUTH - Authorization Codes allow the user to define sets of feature and facility dialing privileges.
- An Authorization Code is associated with the authorization code group and is used to restrict dialing privileges to authorized personnel within the authorization code group.

C
- CAR - The Computer Access Restriction feature provides you the same capability as Selective Call Acceptance (SCA), but it is intended to restrict dial-up access to computers. This feature increases the security of the computer network.
- CFB - The Call Forward Busy feature permits all calls attempting to terminate to a busy telephone number to be redirected to another user specified telephone number.
- CFD - The Call Forward No Answer feature permits all calls attempting to terminate to an idle telephone number to ring that telephone number a specified number of seconds and if the call is not answered, to route the call to another telephone number designated by the user.
- CFV - The Call Forward Variable feature permits all calls attempting to terminate to a telephone number to be redirected to another number without regard to the busy/idle status of the called telephone number.
- CHD - The Call Hold feature provides the user the capability to place an in progress call on hold by flashing the switch hook and dialing the appropriate code. This frees the telephone number (TN) to originate another call.
- CMD - The Calling Name Delivery (CMD) feature, available initially with the 5E6 and 5E7 software releases through a software update, is a terminating line option feature that provides the end-user with both a calling number and a name associated with the calling number.
• CND - The Calling Number Delivery feature allows the incoming calling number, as well as the
time and date of the call, to be displayed on the customer premises telephone equipment after
the first ringing cycle.
• COT - The Customer Originated Trace (COT) feature provides an end-user the ability to trace the
last incoming call by dialing an access code or by pressing the feature button.
• CPBDNT - The Block Directed Call Pickup Terminating feature (CPBDNT) will provide the
capability to prevent another telephone number using the Directed Call Pickup Without Barge In
(CPDDNO) feature from picking up a call terminating to the telephone number assigned the
CPBDNT feature.
• CPDNO - The Directed Call Pickup Originating No Barge In feature provides the capability, when
assigned to a telephone number, to pick up a call terminating to another telephone number in the
same terminal group by dialing the appropriate access code.
• CPO - The Call Pickup Originating feature provides the capability for a telephone number to
answer a call that is ringing at another telephone number in a defined call pickup group.
• CPT - The Call Pickup Terminating feature extends the capability for a call ringing at a telephone
number to be picked up by another telephone number in a predesignated group. The call is
picked up by the other telephone number dialing the appropriate call pickup access code.
• CPUDO - The Call Pickup Originating with Barge In feature, also known as Directed Call Pickup
with Barge In, permits a telephone number to dial a code and a telephone number in order to pick
up a call that is ringing at that telephone number or has been answered by that telephone
number.
• CPUDT - The Call Pickup Terminating with Barge In feature, also known as Directed Call Pickup
Terminating, gives permission for other telephone numbers in the terminal group to pick up a call
at the designated telephone number and to bridge in on a call when that call has already been
answered.
• CPUVT - The Call Pickup Terminating Busy Verify feature gives permission for an ISDN
attendant telephone number to verify if a telephone number is actually busy or if there is trouble in
placing a call.
• CWC - The Cancel Call Waiting feature provides the Call Waiting Terminating service and allows
the user to stop the operation of Call Waiting Terminating, Call Waiting Originating, Dial Call
Waiting, and Barge-In features for one call.
• CWD - The Dial Call Waiting feature provides the user the capability to give call waiting treatment
to a called telephone number.
• CWO - The Call Waiting Originating feature allows a telephone number to send a Call Waiting
tone to an intragroup telephone number that is in a busy state.
• CWT - Call Waiting Terminating is a feature which supplies a telephone number in a talking state
an audible alert when another call attempts to terminate to the telephone number.
• CXR - The Call Transfer feature provides the capability for the user to transfer any established
call to another station.

D-M

• DRING - The Distinctive Ringing feature (DRING) will permit a station user to determine by the
cadence of the ringing, whether a call is internal or external.
• DROP - DROP allows you to drop the last member that was added to the conference.
• EDS - The Electronic Directory Service feature provides users the ability to electronically query a
directory for call and personnel information without attendant assistance.
• HUNTTO - The HUNTTO Feature allows an incoming call to be automatically transferred to
another telephone number if the dialed line is busy
• ICOM - The Intercom feature provides the capability to establish a call between two members of
an intercom group by dialing the intended telephone number with the press of a button or by the
press of a button and dialing either one or two digits.
IDPCAT - The Individualized Dialing Plan feature allows digits to be interpreted according to the individual dialing plan of the user instead of the Office Dialing Plan (ODP).

MSS - The Message Service System feature provides the capability of call coverage by a Message Service Center (MSC). The MSS feature is a directory number feature.

SC1 - The One Digit Speed Calling feature allows you to specify a Speed Calling list containing directory numbers, each of which is associated with a unique Speed Calling code.

SC2 - The Two Digit Speed Calling feature allows you to specify a Speed Calling list containing directory numbers, each of which is associated with a unique Speed Calling code. The speed calling code for 2 digit speed calling is 2 digits.

SCA - The Selective Call Acceptance (SCA) feature allows a customer to preselect incoming calls which are accepted (allowed to complete).

SCF - The Selective Call Forwarding (SCF) feature provides a customer the capability to preselect incoming calls which are call forwarded.

SCR - The Selective Call Rejection (SCR) feature provides a customer with the capability of not being alerted by calls from a preselected DN list.

SDA - The Selective Distinctive Alert (SDA) feature provides capability to preselect incoming calls that receive distinctive alerting.

SUSO - Suspend Origination (SUSO) prevents the set that has SUSO assigned to a telephone number from originating any calls.

SUST - Suspend Terminating (SUST) prevents the set that has SUST assigned to a telephone number from terminating any calls.

SWC - The Six Way Calling feature provides the user the capability to establish a call with up to 5 other telephone numbers.

TGSR - The Terminal Group/Station Restriction (TGSR) feature provides a means of grouping two or more telephone numbers to provide station screening.

TOD - Time of Day is a feature supported in conjunction with the Automatic Route Selection (ARS).

TWC - The Three Way Calling feature allows you to talk with two parties simultaneously without operator assistance.

DMS100 Features

AAB - Automatic Answer Back allows any telephone calls coming to the user on the primary telephone number to be automatically answered in four seconds. The telephone conversation takes place using a hands free unit and ends when the caller hangs up.

ACB - The Automatic Call Back (ACB) allows a customer to contact parties they have been unable to reach or to continue an interrupted conversation.

ACOU - Additional Call Offering Unrestricted notifies the station of an incoming call when all user subscribed B- channels over which the call can be offered, are in use.

ACR - The Anonymous Call Rejection (ACR) feature rejects incoming calls if the calling number is marked private or can not be identified. Rejected calls are automatically forwarded to a rejected call message.

AFC - Additional Functional Calls (AFC) allows multiple calls on a single directory number.

ANSP - The Auto Inspect (ANSP) feature can be assigned to a line to prevent interruptions from callers using Call Waiting or Call Waiting Originating (CWO) features.
AR - The Automatic Recall (AR) option allows a customer to place a call to the last station that called the customer without having to know the telephone number of that call.

AUD - The Automatic Dial (AUD) feature allows you to automatically dial a person by pressing a key on your set.

AUL - When the Automatic Line (AUL) feature is assigned to a telephone, that phone automatically dials a preset number when it goes off-hook.

BLF - The Busy Lamp Field (BLF) feature uses a BSET lamped key to monitor the status of a specified directory number (DN).

BLOCKCND - Block Called Party Number blocks the delivery of the called party number information. When the BLOCKCND option is assigned to an ISDN set, calls no longer terminate to that set. The ISDN set becomes an originate-only set; that is, calls can be made from the set, but cannot receive calls. All calls to a telephone number with this option assigned receive a busy signal.

BLOCKCGN - Block Calling Party Number blocks the delivery of the calling party number information. The BLOCKCGN option controls delivery of the calling party number at the terminating end. Assigning this feature prevents the calling party number from being displayed to that user.

c
CB - The Call Block (CB) feature rejects incoming calls from a set of previously identified directory numbers (DN).

CBE - Call Forward Busy External (CBE) defines the restrictions you place on your calls that are forwarded because your telephone is busy, or you do not answer. The CBE feature restricts you from forwarding calls from outside your customer group. The Call Forward Busy feature must be activated to turn on CBE.

CBI - Call Forward Busy Internal (CBI) defines the call restriction you want to place on your calls that are forwarded because your telephone is busy, or you do not answer. The CBI feature will prevent you from forwarding intragroup calls. The Call Forward Busy feature must be activated to turn on CBI.

CBU - Call Forward Busy Unrestricted (CBU) defines the call restriction placed on calls that are forwarded because your telephone is busy or you do not answer. The CBU feature forwards your calls to another telephone within or outside your customer group. The Call Forward Busy feature must be activated to turn on CBU.

CDE - Call Forward Don't Answer External (CDE) define the restrictions you place on your calls that are forwarded because your telephone is busy, or you do not answer. The CDE feature restricts you from forwarding calls from outside your customer group. The Call Forward Don't Answer feature must be activated to turn on CDE.

CDI - Call Forward Don't Answer Internal (CDI) defines the call restriction you want to place on your calls that are forwarded because your telephone is busy, or you do not answer. The CDI feature will prevent you from forwarding intragroup calls. The Call Forward Don't Answer feature must be activated to turn on CDI.

CDU - Call Forward Don't Answer Unrestricted (CDU) defines the call restriction placed on calls that are forwarded because your telephone is busy or you do not answer. The CDU feature forwards your calls to another telephone within or outside your customer group. The Call Forward Don't Answer feature must be activated to turn on CDU.

CF - The Customer Centrex Manager supports multiple call forwarding options under the umbrella category of Call Forwarding (CF).

CFB - Call Forward Busy (CFB) will forward incoming calls to another number when your telephone is busy or if your telephone does not get answered. You must designate whether you want CFB always active, whether you want it activated through a code using a predefined forwarding telephone number, or activated through a code and specifying the telephone number each time you activate the feature.
CFD - Call Forward Don’t Answer (CFD) will forward incoming calls to another number when your telephone does not get answered. You must designate whether you want CFD always active, whether you want it activated through a code using a predefined forwarding telephone number, or activated through a code and specifying the telephone number each time you activate the feature.

CFDVT - The Call Forward Don’t Answer Variable Timing (CFDVT) feature will allow you to change the length of time your telephone will ring before it gets forwarded to another number.

CFF - Call Forward Fixed (CFF) is another option available among the call forwarding family. This will forward your telephone calls to a fixed telephone number. This feature is available for the single line set, BSET and ISDN sets. It is assigned as a station feature which means you will activate it by dialing a special code.

CFI - Call Forward Intragroup (CFI) is another option available among the call forwarding family. This restricts the call forwarding of your incoming calls to a telephone number within your customer group.

CFK - Call Forward Per Key (CFK) is another option available among the call forwarding family. This will allow you to forward the calls for each directory number appearing on your set to a different telephone number.

CFSMADN - The Call Forwarding for Secondary MADN Members (CFSMADN) feature will allow you to forward your telephone calls when you are not the primary member of a MADN group.

CFU - Call Forward Universal (CFU) is another option available among the call forwarding family options. This option allows the end user to forward calls to a telephone number inside or outside of the customer group.

CFXDNCT - Call Forward per DN/CT option offers call forwarding capabilities on a per directory number, per call type basis. By using this option, a National ISDN terminal can forward call types to different destinations.

CFXVAL - Call Forwarding Validation (CFXVAL) provides remote TN validation or courtesy call to the terminal that has Call Forwarding assigned. CFXVAL may validate the call forward remote TN by either making a validation courtesy call or not. In some cases, based on the type of switch the feature is assigned in, you may be able to set a Courtesy Call option or select from a list of choices. Although this feature can be added to a terminal with or without call forwarding, it’s functionality is only useful if Call Forwarding is assigned.

CHD - Call Hold (CHD) allows you to hold a call until you hang up or the caller hangs up the telephone.

CIDSDLV - Caller ID Delivery enables the subscriber to deliver the call originator’s name and number, according to each call. This option can be added to key 1 or to a feature key, and can apply to a subset of telephone numbers.

CIDSSUP - Caller ID Suppression enables the subscriber to block the delivery of the call originator’s name and number, according to each call. This option can be added to key 1 or to a feature key, and can apply to a subset of call appearances.

CMD - Calling Name Delivery (CMD) is a Class Feature® that provides the capability to display the name associated with the calling party.

CNMAD - Calling Name Delivery provides the capability to display the name associated with the calling party.

CND - Calling Number Delivery (CND) is a Class Feature which provides the capability to display the calling number as well as the time and date of the call on your phone equipment after the first ringing cycle.

CNDB - Calling Number Delivery Blocking (CNDB) is a Class Feature that allows the delivery of the calling number to be blocked.

CNF - Station controlled conference (CNF) allows you to establish a conference call consisting of more than three conferees without assistance from an attendant.

COT - Customer Originated Trace (COT) is a Class Feature that allows you to request an automatic trace of the last incoming call. The COT request is initiated when you dial the activation code after an incoming call or press the associated button on Business or ISDN sets.
CPU - Call Pickup (CPU) allows you to pick up someone else’s telephone from your own telephone if both lines are within the same group by dialing an activation code or pressing a CPU key.

CSL - The Call Selector (CSL) feature identifies certain incoming calls using a distinctive alert pattern: a distinctive ring, or if busy, a distinctive call waiting tone. The caller hears the standard ring back tone.

CWD - The Dial Call Wait (CWD) feature allows the station user to impose Call Waiting on a busy station when making an intragroup call. CWD differs from the Call Waiting Originating (CWO) feature because the user must dial an access code followed by the called station extension number to activate Call Waiting.

CWI - The Call Waiting Intragroup (CWI) feature can be assigned on a per line basis to any line assigned the Call Waiting feature. This enables an intragroup call to be call waited.

CWO - The Call Waiting Originating (CWO) feature allows you to impose call waiting on a busy station within the same customer group. CWO differs from Call Waiting in that the calling party is able to hear either music or a recorded announcement in addition to audible ringing.

CWT - Call Waiting Terminating (CWT) allows you to be informed of an incoming call from outside your customer centrex group while you are talking on your telephone. To be informed of an incoming call from within your group while you are talking on the telephone, you must also assign CWI to the line.

CWX - The Call Waiting Exempt (CWX) feature can be assigned to a line to prevent interruptions from callers using Call Waiting (CW) or Call Waiting Originating (CWO) features.

CXR - Call Transfer (CXR) allows you to transfer a call to another person.

DCBI - Directed Call Pickup Barge-In (DCBI) allows you to pick up unanswered calls on your line.

DCBX - Directed Call Pickup Barge-In Exempt (DCBX) will prohibit a person from barging into the call you have just picked up.

DCF - Denied Call Forwarding is used to prevent a line from receiving forwarded calls. This security option is useful especially for computer ports.

DCPK - Directed Call Park (DCPK) will allow you to answer a call and "park" it on another directory number to be retrieved from any station within your customer group.

DCPU - Directed Call Pickup (DCPU) allows you to pick up unanswered calls on your line.

DCPX - Directed Call Pickup Exempt (DCPX) will prohibit a person from picking up your unanswered telephone, and from barging into an unanswered call you may pick up.

DGT - Digit Tone (DGT) will allow you to support dial tone for a telephone set.

DIN - Denied Incoming (DIN) will allow you to keep selected telephone lines from receiving calls from outside your customer group.

DNH - The Directory Number Hunt (DNH) feature will continue to forward a call that was initially sent to a busy telephone number through a sequence of numbers within a DNH group until it finds an idle line that can answer that call.

DOR - Denied Originate (DOR) will restrict you from making telephone calls.

DROP - DROP allows you to drop the last member that was added to the conference.

DTM - The Denied Termination (DTM) restricts incoming calls to a phone set.

EBO - Executive Busy Override, Originator (EBO) will allow you to access a busy telephone.

EBX - Executive Busy Override Exempt (EBX) will keep others that have EBO from accessing your busy telephone.

EHLD - Electronic Key Telephone Service Hold (EHLD) will automatically place the current call on hold as you access another call on your telephone set.

FC - Flexible Calling (FC) allows you to connect a third party to your telephone conversation, forming a three way conference.

GIC - Group Intercom (GIC) allows you to dial another person within your defined intercom group by dialing an abbreviated number.
- HLD - Permanent Hold (HLD) will allow you to hold a call against your own directory number using a key.
- ICM - Personal Intercom (ICM) allows you to press a key on your set to send a buzzing tone to another predesignated telephone set. The call will be completed between the two sets if the set you are calling has one idle directory number when you press your ICM key.
- IECFB - Internal and External Split of Call Forward Busy (IECFB) defines the call restriction you want to place on your calls that are forwarded because your telephone is busy.
- IECFD - Internal and External Split of Call Forward Don't Answer (IECFD) defines the call restriction you want to place on your calls that are forwarded because you do not answer.
- INSP - The Inspect (INSP) feature provides options for gathering information about incoming calls, station feature keys, and directory number (DN) appearances.
- KSH - Key Short Hunt (KSH) allows you to have your incoming calls search through all or a select number of directory numbers on your set to find an idle line.
- KSMOH - When an incoming call, to a station with Music on Hold, is placed on hold it is connected to an audio (music) source. When the station user retrieves the call, the party on hold is disconnected from the audio source and reconnected to the station user.

L-P

- LNR - Last Number Redial (LNR) will allow you to redial the last number that was dialed from your set without having to dial the number again.
- LNRA - Last Number Redial From Set (LNRA) will allow you to redial the last number that was dialed from your set, from any free directory number appearing on your set, without having to dial the number again.
- MADN - Multiple Appearance Directory Number. This functionality allows an analog line to have multiple call appearances on other stations within the Centrex group.
- MCH - Malicious Call Hold (MCH) will allow you to place a call on hold so a trace can be done on the call from the switch. This is generally used if you have an abusive caller.
- MCMP - The Station Camp On (MCMP) feature enhances Call Transfer (CXR) BSET capabilities by allowing the station user to transfer a call to a busy station.
- MRF - You may select ringing options for Multiple Appearance Directory Numbers (MADNs) having the Single Call Arrangement (SCA).
- MRFM - The MADN Ring Forward Manual (MRFM) feature is an enhancement to the ringing options available for the Multiple Appearance Directory Numbers (MADNs) having the Single Call Arrangement (SCA).
- MSB - The Make Set Busy (MSB) feature will make your telephone appear to be busy for people calling you. You may continue to make outgoing calls while this is active on your set.
- MSBI - The Make Set Busy Intragrupo (MSBI) feature will make your telephone appear to be busy for people calling you from within your customer group. People calling you from outside your customer group will ring through.
- MWT - The Message Waiting (MWT) feature will allow you to receive an indication that you have a message from someone who called you and your telephone was either busy or you didn’t answer.
- NAME - The Name Display (NAME) will allow you to provide identification for your Network Name and also for the name you want displayed when calling someone with a display on their telephone.
- NCOS - Network Class of Service Assignment Codes specified for a particular telephone number. The NCOS code specifies the calling privileges for phone calls going through the network. It also gives a Centrex line explicit call processing instructions. NCOS codes are established by your Local Exchange Carrier (LEC). Every telephone number has an assigned NCOS code. NCOS elements must include an NCOS name, Line Screening Code and traffic separation number.
- NDC - The No Double Connect (NDC) feature will protect any special lines that you would prefer not to make available for a test or for busy overrides.
• OLS - The Originating Line Select (OLS) feature offers various line selection options when placing calls.
• PBL - The Private Business Line (PBL) feature will allow you to simulate a private telephone line on one of the keys on your set. This means you do not have to dial a prefix (commonly 9 or 8) to call someone outside your customer group.
• PCACIDS - The Privacy Change Allowed feature gives control to allow or disallow subscriber ability to restrict or allow privacy status changes. The PI or presentation indicator (PI) is set by line option PCACIDS.
• PCF - The Preferred Call Forward (PCF) feature allows you to define a list of possible incoming directory numbers (DN) and a target destination number.
• PRK - Call Park (PRK) will allow you to park a call against your telephone number, and then continue to make or receive calls on your telephone number.
• PRL - If you are in a MADN Single Call Arrangement group and you have the bridging capability, you may assign Privacy Release (PRL) to a vacant key and this will allow you to establish a conference call among MADN lines within your group and an outside caller.
• PRV - If you are in a MADN Single Call Arrangement group and you have the bridging capability, you may assign Privacy (PRV) to a vacant key and use this key to toggle the privacy on and off.

Q-Z

• QBS - The Query Busy Station (QBS) feature monitors the set status of a specified telephone number. When the station user presses the QBS key, the associated lamp indicates the telephone number station status.
• QTD - Query Time and Date (QTD) will display the current time and date on your display box on your BSET set.
• RAG - When you call someone and the line is busy, you may activate the Ring Again (RAG) feature and then hang up your telephone. As soon as the person you called is off their telephone you will get a ring back tone. When you pick up your telephone set, the telephone for the person you were trying to reach will begin ringing.
• REASDSP - The Reason Display (REASDSP) feature will display on the display box of your BSET or ISDN set, the reason why a call was redirected.
• RLS - For some features, you may cancel the feature programming from your set by pressing the Release Key (RLS).
• RSUS - The Request Suspend (RSUS) feature will allow you to suspend incoming calls to your line and give the caller an announcement or some type of special treatment. This will also allow you to suspend calls from being made from your telephone and give the person dialing on your set a stutter dial tone or some type of special treatment.
• SCA - Selective Call Accept (SCA) accepts incoming calls from a set of previously identified directory numbers (DN). Use the Screening List Editing (SLE) feature to build the list of accepted DNs.
• SCL - Speed Call allows you to make calls by using an abbreviated number instead of the full telephone number. The Speed Call Long (SCL) feature allows you to establish a Speed Call Long (SCL) list with you as the owner of the list.
• SCMP - Series Completion (SCMP) is a feature which allows you to redirect incoming calls to another telephone number when your telephone number is "busy".
• SCS - Speed Call allows you to make calls using an abbreviated number instead of the full telephone number. The Speed Calling Short (SCS) feature will allow you to have your own personal speed call list which provides up to ten telephone numbers.
• SCU - Speed Call allows you to make calls using an abbreviated number instead of the full telephone number. The Speed Call User (SCU) feature will allow you to use a speed call list that is owned by someone else have the SCL feature.
• SOR - The Station Originating Restriction (SOR) feature enables a station to have its dialing restrictions modified by someone with Station Outgoing Restriction Control (SORC) capabilities.
● SORC - The Station Outgoing Restriction Control (SORC) feature enables a station user to place calling restrictions on another directory number (DN) or a group of DNs in the same SOR group.

● SSAC - The Station Specific Authcode (SSAC) feature allows you to restrict an authorization code to a specific phone set. This limitation increases security by proving that calls are made by the person using a particular SSAC, since the authorization code is linked to that person's station.

● SUPAC - Super Authorization Codes - These codes allow access to privileges provided by an Authorization Code from any station.

● SW - System Wide Authorization Codes - These codes are used to access long distance services from phones in public areas. The codes can be accessed from all stations except those with SSAC assigned.

● TLS - The Terminating Line Select (TLS) feature offers various line selection options when answering calls.

● TRANSFER - Transfer is a sub-option of the Flexible Calling (FC) feature. Transfer allows a FC subscriber to establish two types of transfers; conference transfers where remaining conferees continue to be connected to each other after the controller exits and call-to-call transfers where a party from one non-conference call is transferred to another party from another non-conference call.

● TWC - Three Way Calling (TWC) allows you to jump between calls or have a three way conversation with two other calls.

● UCD - Uniform Call Distribution (UCD) allows you to distribute calls equitably among a predetermined group of stations.

● UCDLG - UCD Auto Login (UCDLG) allows a BSET station with the Uniform Call Distribution (UCD) feature to "log" into a predefined UCD group automatically, enabling the user to depress a key and become a member of the designated UCD group without dialing an access code or dialing a lead "prime" DN.

● XFER - Another option of the flexible calling arrangement is the type of call transfer (XFER) restrictions you would like to place on this set.